Topcon only sells GPS products into Precision Markets. Please go to www.topcongps.com for detailed market information.
Table of Contents

Chapter 1
Introduction ............................................................... 1-1
Principles of Operation ................................................. 1-2
  GNSS Overview ......................................................... 1-2
    Calculating Absolute Positions ................................. 1-3
    Calculating Differential Positions ............................. 1-4
    Essential Components for Quality Surveying .................. 1-5
    Conclusion ............................................................ 1-5
  GMS-2 Overview ....................................................... 1-6
Getting Acquainted with the GMS-2 ................................. 1-7
  Rechargeable and Backup Batteries ............................. 1-8
  GMS-2 Front ............................................................ 1-8
  GMS-2 Back ............................................................. 1-10
  GMS-2 Ports ............................................................ 1-10
  SD Card Slot ......................................................... 1-11
  Integrated Camera .................................................... 1-11
  External GPS Antenna Connector ................................. 1-12
  System Cables .......................................................... 1-12
  GMS-2 Software ....................................................... 1-13
  Optional Accessories ............................................... 1-14
  Option Authorization File (OAF) ................................. 1-16

Chapter 2
Preparing the GMS-2 for Use ........................................ 2-1
  Attaching the Hand Strap .......................................... 2-1
  Powering the GMS-2 .................................................. 2-2
    Charging the Battery ............................................... 2-2
    Charging and Battery Storage Notes ........................... 2-4
    Installing the Battery ............................................. 2-4
    Replacing the Backup Battery .................................... 2-5
  Starting the GMS-2 ................................................... 2-7
# Table of Contents

Installing Software ........................................................... 2-8
Installing an Optional SD Card ........................................ 2-9

## Chapter 3

### Using the GMS-2 ................................. 3-1

- Connecting the GMS-2 with Other Devices ................. 3-1
- Connecting the GMS-2 and a Computer .................. 3-2
- Connecting the GMS-2 and a Bluetooth Device ....... 3-3
- Surveying with the GMS-2 (Using GMS Tools) .......... 3-5
- Surveying with the GMS-2 ........................................ 3-5
- Surveying with the GMS-2 and an External Antenna 3-6
- Surveying with the GMS-2 and a Beacon Receiver .. 3-7
- Surveying with the GMS-2 and an External GPS Receiver .................................................. 3-8
- Backing up Windows CE RAM Data ...................... 3-9

## Chapter 4

### Using the Camera and Compass ........................ 4-1

- GMS Tools ................................................................. 4-1
- Getting Acquainted .................................................... 4-1
- Working with GMS Tools ......................................... 4-3
- Using the Camera ................................................ 4-3
- Using the Compass .............................................. 4-5
- Viewing GNSS Information and Logging Data .. 4-7
- Keeping Internal GNSS Power On ..................... 4-8
- Clearing the NVRAM ......................................... 4-9

## Chapter 5

### Using the Bluetooth Manager ............................. 5-1

- Getting Started .......................................................... 5-1
- Getting Acquainted .................................................... 5-2
- Working with Bluetooth Manager ......................... 5-5
- Discovering Devices ................................................ 5-6
- Adding to the List of Favorite Devices ................. 5-8
- Viewing Device Properties ..................................... 5-10
- Deleting a Device from the List ......................... 5-11
- Setting Device Preferences ................................... 5-11
- Pairing Bluetooth Devices ................................... 5-13
Table of Contents

Chapter 6
**Troubleshooting** ................................................... 6-1
  - Check This First! ......................................................... 6-1
  - Troubleshooting Quick List ........................................... 6-2
  - Resetting the Software .................................................. 6-3
  - Restoring Bluetooth Module Defaults ............................. 6-3
  - Resetting the Hardware .................................................. 6-4
  - Charging/Powering Problems .......................................... 6-5
  - GMS-2 Problems ............................................................ 6-5
  - Bluetooth Problems ......................................................... 6-6
  - Obtaining Technical Support ........................................... 6-8
    - Phone ........................................................................ 6-8
    - E-mail ....................................................................... 6-9
    - Website ...................................................................... 6-10

Appendix A
**Specifications** ....................................................... A-1
  - GMS-2 Specifications .................................................... A-2
  - General Details .......................................................... A-2
  - GPS Details ............................................................... A-5
  - Connector Specifications ................................................. A-6
    - Serial Connector ......................................................... A-6
    - USB Connector ........................................................ A-7

Appendix B
**Safety Warnings** ..................................................... B-1
  - General Warnings ........................................................ B-1
  - Battery Pack Warnings .................................................. B-1
  - Usage Warnings ........................................................... B-2

Appendix C
**Regulatory Information** ............................................. C-1
  - FCC Compliance ........................................................... C-1
  - Canadian Emission Labeling Requirements ........................ C-2
  - Community of Europe Compliance ................................... C-2
  - WEEE Directive .............................................................. C-3
Appendix D
Warranty Terms ......................................................... D-1
Preface

Thank you for purchasing this Topcon product. The materials available in this Manual (the “Manual”) have been prepared by Topcon Positioning Systems, Inc. (“TPS”) for owners of Topcon products, and are designed to assist owners with the use of the receiver and its use is subject to these terms and conditions (the “Terms and Conditions”).

NOTICE
Please read these Terms and Conditions carefully.

Terms and Conditions

USE This product is designed to be used by a professional. The user should have a good knowledge of the safe use of the product and implement the types of safety procedures recommended by the local government protection agency for both private use and commercial job sites.

COPYRIGHT All information contained in this Manual is the intellectual property of, and copyrighted material of TPS. All rights are reserved. You may not use, access, copy, store, display, create derivative works of, sell, modify, publish, distribute, or allow any third party access to, any graphics, content, information or data in this Manual without TPS’ express written consent and may only use such information for the care and operation of your receiver. The information and data in this Manual are a valuable asset of TPS and are developed by the expenditure of considerable work, time and money, and are the result of original selection, coordination and arrangement by TPS.
TRADEMARKS GMS-2, GMS Tools, BTManager, TopSURV, TopPAD, HiPer, Topcon and Topcon Positioning Systems are trademarks or registered trademarks of TPS. Microsoft, Windows, ActiveSync, and the Windows logo are either trademarks or registered trademarks of Microsoft Corporation in the United States and/or other countries. The Bluetooth® word mark and logos are owned by Bluetooth SIG, Inc. and any use of such marks by Topcon Positioning Systems, Inc. is used under license. Other product and company names mentioned herein may be trademarks of their respective owners.

DISCLAIMER OF WARRANTY EXCEPT FOR ANY WARRANTIES IN AN APPENDIX OR A WARRANTY CARD ACCOMPANYING THE PRODUCT, THIS MANUAL AND THE RECEIVER ARE PROVIDED “AS-IS.” THERE ARE NO OTHER WARRANTIES. TPS DISCLAIMS ANY IMPLIED WARRANTY OF MERCHANTABILITY OR FITNESS FOR ANY PARTICULAR USE OR PURPOSE. TPS AND ITS DISTRIBUTORS SHALL NOT BE LIABLE FOR TECHNICAL OR EDITORIAL ERRORS OR OMISSIONS CONTAINED HEREIN; NOR FOR INCIDENTAL OR CONSEQUENTIAL DAMAGES RESULTING FROM THE FURNISHING, PERFORMANCE OR USE OF THIS MATERIAL OR THE RECEIVER. SUCH DISCLAIMED DAMAGES INCLUDE BUT ARE NOT LIMITED TO LOSS OF TIME, LOSS OR DESTRUCTION OF DATA, LOSS OF PROFIT, SAVINGS OR REVENUE, OR LOSS OF THE PRODUCT’S USE. IN ADDITION TPS IS NOT RESPONSIBLE OR LIABLE FOR DAMAGES OR COSTS INCURRED IN CONNECTION WITH OBTAINING SUBSTITUTE PRODUCTS OR SOFTWARE, CLAIMS BY OTHERS, INCONVENIENCE, OR ANY OTHER COSTS. IN ANY EVENT, TPS SHALL HAVE NO LIABILITY FOR DAMAGES OR OTHERWISE TO YOU OR ANY OTHER PERSON OR ENTITY IN EXCESS OF THE PURCHASE PRICE FOR THE RECEIVER.

LICENSE AGREEMENT Use of any computer programs or software supplied by TPS or downloaded from a TPS website (the “Software”) in connection with the receiver constitutes acceptance of these Terms and Conditions in this Manual and an agreement to abide by these Terms and Conditions. The user is granted a personal, non-exclusive,
non-transferable license to use such Software under the terms stated herein and in any case only with a single receiver or single computer. You may not assign or transfer the Software or this license without the express written consent of TPS. This license is effective until terminated. You may terminate the license at any time by destroying the Software and Manual. TPS may terminate the license if you fail to comply with any of the Terms or Conditions. You agree to destroy the Software and manual upon termination of your use of the receiver. All ownership, copyright and other intellectual property rights in and to the Software belong to TPS. If these license terms are not acceptable, return any unused software and manual.

CONFIDENTIALITY This Manual, its contents and the Software (collectively, the “Confidential Information”) are the confidential and proprietary information of TPS. You agree to treat TPS’ Confidential Information with a degree of care no less stringent that the degree of care you would use in safeguarding your own most valuable trade secrets. Nothing in this paragraph shall restrict you from disclosing Confidential Information to your employees as may be necessary or appropriate to operate or care for the receiver. Such employees must also keep the Confidentiality Information confidential. In the event you become legally compelled to disclose any of the Confidential Information, you shall give TPS immediate notice so that it may seek a protective order or other appropriate remedy.

WEBSITE; OTHER STATEMENTS No statement contained at the TPS website (or any other website) or in any other advertisements or TPS literature or made by an employee or independent contractor of TPS modifies these Terms and Conditions (including the Software license, warranty and limitation of liability).

SAFETY Improper use of the receiver can lead to injury to persons or property and/or malfunction of the product. The receiver should only be repaired by authorized TPS warranty service centers. Users should review and heed the safety warnings in an Appendix.
MISCELLANEOUS  The above Terms and Conditions may be amended, modified, superseded, or canceled, at any time by TPS. The above Terms and Conditions will be governed by, and construed in accordance with, the laws of the State of California, without reference to conflict of laws.

## Manual Conventions

This manual uses the following conventions:

<table>
<thead>
<tr>
<th>Example</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>File ▶ Exit</td>
<td>Click the <strong>File</strong> menu and click <strong>Exit</strong>.</td>
</tr>
<tr>
<td><strong>Connection</strong></td>
<td>Indicates the name of a dialog box or screen.</td>
</tr>
<tr>
<td><strong>Frequency</strong></td>
<td>Indicates a field on a dialog box or screen, or a tab within a dialog box or screen.</td>
</tr>
<tr>
<td><strong>Enter</strong></td>
<td>Press or click the button or key labeled <strong>Enter</strong>.</td>
</tr>
</tbody>
</table>

---

**NOTE**

Further information to note about the configuration, maintenance, or setup of a system.

---

**TIP**

Supplementary information that can help you configure, maintain, or set up a system.

---

**WARNING**

Supplementary information that can have an affect on system operation, system performance, measurements, or personal safety.

---

**CAUTION**

Notification that an action has the potential to adversely affect system operation, system performance, data integrity, or personal health.
Manual Conventions

**WARNING**

Notification that an action *will* result in system damage, loss of data, loss of warranty, or personal injury.

**DANGER**

Under no circumstances should this action be performed.
Preface

Notes:

________________________________________________________________________

________________________________________________________________________

________________________________________________________________________

________________________________________________________________________

________________________________________________________________________

________________________________________________________________________

________________________________________________________________________

________________________________________________________________________

________________________________________________________________________

________________________________________________________________________

________________________________________________________________________

________________________________________________________________________

________________________________________________________________________

________________________________________________________________________

________________________________________________________________________

________________________________________________________________________
Chapter 1

Introduction

The GMS-2 receiver is a single-frequency, GPS+GLONASS L1 receiver and hand-held controller built to be the most advanced, compact, and portable receiver for the GIS surveying market. An integrated electronic compass and digital camera make the GMS-2 an all-purpose, GIS field mapping unit.

The GMS-2 receiver is a multi-function, multi-purpose receiver intended for precision markets. Precision markets means markets for equipment, subsystems, components and software for surveying, construction, commercial mapping, civil engineering, precision agriculture and land-based construction and agriculture machine control, photogrammetry mapping, hydrographic and any use reasonably related to the foregoing.

The GMS-2 provides the functionality, accuracy, availability, and integrity needed for fast and easy data collection.

Figure 1-1. GMS-2
Principles of Operation

Surveying with the right GPS receiver can provide users accurate and precise positioning, a requirement for any surveying project. This section gives an overview of existing and proposed Global Navigation Satellite Systems (GNSS) and receiver functions to help you understand and apply basic operating principles, allowing you to get the most out of your receiver.

GNSS Overview

Currently, the following three global navigation satellite systems (GNSS) offer line-of-site radio navigation and positioning, velocity, and time services on a global, all-weather, 24-hour scale to any user equipped with a GNSS tracking receiver on or near the Earth’s surface:

- GPS – the Global Positioning System maintained and operated by the United States Department of Defense. For information on the status of this system, visit the US Naval Observatory website (http://tycho.usno.navy.mil/) or the US Coast Guard website (http://www.navcen.uscg.gov/).
- GLONASS – the Global Navigation Satellite System maintained and operated by the Russian Federation Ministry of Defense. For information on the status of this system, visit the Ministry of Defense website (http://www.glonass-center.ru/frame_e.html).
- GALILEO – an upcoming global positioning system maintained and operated by Galileo Industries, a joint venture of several European space agencies working closely with the European Space Agency. Unlike GPS and GLONASS, this is a civil endeavor and is currently in the development and validation stage. For information on the status of this system, visit the Galileo Industries website (http://www.galileo-industries.net).
Despite numerous technical differences in the implementation of these systems, satellite positioning systems have three essential components:

- **Space** – GPS, GLONASS, and GALILEO satellites orbit approximately 12,000 nautical miles above Earth and are equipped with a clock and radio. These satellites broadcast digital information (ephemerides, almanacs, time & frequency corrections, etc.).

- **Control** – Ground stations located around the Earth that monitor the satellites and upload data, including clock corrections and new ephemerides (satellite positions as a function of time), to ensure the satellites transmit data properly.

- **User** – The community and military that use GNSS receivers and the corresponding satellites to calculate positions.

### Calculating Absolute Positions

When calculating an absolute position, a stationary or moving receiver determines its three-dimensional position with respect to the origin of an Earth-Center Earth-Fixed coordinate system. To calculate this position, the receiver measures the distance (called pseudo-ranges) between it and at least four satellites. The measured pseudo-ranges are corrected for clock differences (receiver and satellites) and signal propagation delays due to atmospheric effects. The positions of the satellites are computed from the ephemeris data transmitted to the receiver in navigation messages. When using a single satellite system, the minimum number of satellites needed to compute a position is four. In a mixed satellite scenario (GPS, GLONASS, GALILEO), the receiver must lock onto at least five satellites to obtain an absolute position.

To provide fault tolerance using only GPS or only GLONASS, the receiver must lock onto a fifth satellite. Six satellites will provide fault tolerance in mixed scenarios.
Calculating Differential Positions

DGPS, or Differential GPS, typically uses the measurements from two or more remote receivers to calculate the difference (corrections) between measurements, thus providing more accurate position solutions.

With DGPS, one receiver is placed at a known, surveyed location and is referred to as the reference receiver or base station. Another receiver is placed at an unknown, location and is referred to as the remote receiver or rover. The reference station collects the range measurements from each GPS satellite in view and forms the differences (corrections) between the calculated distance to the satellites and the measured pseudo-ranges to the satellites.

These corrections are then built up to the industry standard (RTCM or various proprietary standards) established for transmitting differential corrections and broadcast to the remote receiver(s) using a data communication link. The remote receiver applies the transmitted DGPS corrections to its range measurements of the same satellites.

Using this technique, the spatially correlated errors—such as satellite orbital errors, ionospheric errors, and tropospheric errors—can be significantly reduced, thus improving the position solution accuracy of the GPS.

A number of differential positioning implementations exist, including post-processing surveying, real-time kinematic surveying, maritime radio beacons, geostationary satellites (as with the OmniSTAR service), and the wide area augmentation system (WAAS) service.

The real-time kinematic (RTK) method is the most precise method of real-time surveying. RTK requires at least two receivers collecting navigation data and communication data link between the receivers. One of the receivers is usually at a known location (Base) and the other is at an unknown location (Rover). The Base receiver collects carrier phase measurements, generates RTK corrections, and sends this data to the Rover receiver. The Rover processes this transmitted data with its own carrier phase observations to compute its relative position with high accuracy, achieving an RTK accuracy of up to 1 cm horizontal and 1.5 cm vertical.
Essential Components for Quality Surveying

Achieving quality position results requires the following elements:

- **Accuracy** – The accuracy of a position primarily depends upon the satellite geometry (Geometric Dilution of Precision, or GDOP) and the measurement (ranging) errors.
  - Differential positioning (DGPS and RTK) strongly mitigates atmospheric and orbital errors, and counteracts Selective Availability (SA) signals the US Department of Defense transmits with GPS signals.
  - The more satellites in view, the stronger the signal, the lower the DOP number, the higher positioning accuracy.

- **Availability** – The availability of satellites affects the calculation of valid positions. The more visible satellites available, the more valid and accurate the position. Natural and man-made objects can block, interrupt, and distort signals, lowering the number of available satellites and adversely affecting signal reception.

- **Integrity** – Fault tolerance allows a position to have greater integrity, increasing accuracy. Several factors combine to provide fault tolerance, including:
  - Receiver Autonomous Integrity Monitoring (RAIM) detects faulty GPS and GLONASS satellites and removes them from the position calculation.
  - Five or more visible satellites for only GPS or only GLONASS; six or more satellites for mixed scenarios.
  - Wide Area Augmentation Systems (WAAS, EGNOS, etc.) creates and transmit, along with DGPS corrections, data integrity information (for example, satellite health warnings).
  - Current ephemerides and almanacs.

**Conclusion**

This overview simply outlines the basics of satellite positioning. For more detailed information, visit the TPS website.
Introduction

GMS-2 Overview

The GMS-2 is a fully integrated hand-held controller and GPS+ receiver. Included in the system is an electronic compass and digital camera.

The hand-held controller component of the GMS-2 includes the Windows® CE operating system and color LCD touch screen. Integrated Bluetooth® wireless technology allows this system to be a cable-free controller/receiver for maximum portability. The casing is durable and built for rugged use.

As a field controller, the GMS-2 can run a full suite of field software for working with total stations and RTK GPS systems.

The GPS+ receiver component of the GMS-2 can receive and process GPS+GLONASS L1 signals improving the accuracy of your survey points and positions. The GPS+ features of the receiver combine to provide a positioning system accurate for any survey. Several other features, including multipath mitigation, provide under-canopy and low signal strength reception.

When power is turned on and the receiver self-test completes, the receiver’s 50 channels initialize and begin tracking visible satellites. Each of the receiver’s channels can be used to track any one of the GPS or GLONASS signals. The number of channels available allows the receiver to track all visible GPS satellites at any time and location.

An internal GPS antenna equipped with a low noise amplifier (LNA) and the receiver’s radio frequency (RF) device are connected with a coaxial cable. The wide-band signal received is down-converted, filtered, digitized, and assigned to different channels. The receiver processor controls the process of signal tracking.

Once the signal is locked in the channel, it is demodulated and necessary signal parameters (carrier and code phases) are measured. Also, broadcast navigation data are retrieved from the navigation frame.

After the receiver locks on to four or more satellites, it is possible to solve the so-called “absolute positioning problem” and compute the receiver’s coordinates (in WGS-84) and the time offset between the
Getting Acquainted with the GMS-2

receiver clock and GPS time. All this information can be stored in the
the optional SD card and internal flash memory, then processed using
a post-processing software package.

Capabilities of the GMS-2 receiver include:

- Multipath reduction
- Wide area augmentation system (WAAS)
- Single-frequency static, kinematic, and differential GPS (DGPS)
  survey modes
- Setting different mask angles
- Setting different survey parameters

The integrated 1.3 megapixel camera is used for taking pictures of
surveyed objects or survey sites.

Getting Acquainted with the GMS-2

The GMS-2 is an integrated field controller and 50-channel GPS
receiver with an internal electronic compass and digital camera. USB
and serial ports, along with Bluetooth® wireless technology provide
communication paths with other devices. An external GPS antenna
connector allows an optional PG-A5 antenna to be connected for
centimeter-level surveys.

The standard GMS-2 package contains the following items:

- GMS-2 integrated receiver/controller activated for GPS L1
  signals
- Handstrap and soft case
- USB cable and power converter/adapter cable
- BTManager and GMS Tools factory-installed software

For more details on accessories and options available for the GMS-2,
contact your local Topcon dealer.
Rechargeable and Backup Batteries

The GMS-2 comes equipped with a rechargeable battery (Figure 1-2) for powering the unit. The battery can be charged in the unit or in an optional battery charger. A backup battery is also located in the battery pocket and the unit’s serial number is located under the battery.

The battery provides seven hours of operation, depending on the mode of the receiver. Under normal conditions, the backup battery provides eight to ten years of power backup for data and system integrity.

GMS-2 Front

The front of the GMS-2 (Figure 1-3 on page 1-9) is the primary interface with its components and installed software.

- The internal GPS antenna detects signals from GPS+ satellites and sends them to the GPS receiver board for processing.
- The display screen and touch panel provides a graphical and tactile user interface for the unit.
- The power button turns the receiver on and off.
- The **ESC (escape) button** exits from the current screen or function. Pressing this button for one second or more opens the Microsoft Windows Start menu.

- The **ENT (enter) button** applies settings, numerical values, and records points (depending on the settings of internal software).

- The **Bluetooth LED** indicates the level of activity at the Bluetooth wireless technology module:
  - Solid blue light: the module is on and a connection has been established.
  - No light: the module is off.

- The **charging LED** indicates the level of charge in the battery:
  - Green: battery has a full charge.
  - Red: battery is charging.
  - Red blink: charging error.

![Figure 1-3. GMS-2 Front](image)
GMS-2 Back

The back of the GMS-2 holds the stylus used for tapping on the display screen. An elastic strap provides comfortable security while using the GMS-2. A cover accesses the rechargeable battery and backup battery.

GMS-2 Ports

The GMS-2 has the following three ports:

- USB – used for high-speed connection to a computer via ActiveSync.
- Serial – used for communication between the internal GPS module (port A of the module) and an external device.
- Power – used to connect the GMS-2 to an external power source. This port can also be used to charge the batteries.
SD Card Slot

The SD (secure digital) slot provides extended memory for the controller (Figure 1-6). The data that resides on the SD card can be accessed via the USB or serial port, or Bluetooth wireless technology. A secure digital card can be purchased at your local computer supply store.

Located above the card slot is the software reset button for restarting the operating system if software is not responding.

Integrated Camera

The integrated 1.3 megapixel camera can be used for taking pictures.
External GPS Antenna Connector

The external GPS antenna connector allows an optional external antenna to be connected to the controller for post-process survey applications.

![External GPS Antenna Connector](image)

System Cables

The GMS-2 package includes standard communication and power cables for communicating with the GMS-2 and providing a power source. Table 1-1 lists the cables included in the standard GMS-2 package.

<table>
<thead>
<tr>
<th>Cable Description</th>
<th>Cable Illustration</th>
</tr>
</thead>
<tbody>
<tr>
<td>AC Power cable and adapter</td>
<td><img src="image" alt="AC Power Cable" /></td>
</tr>
<tr>
<td>Connects the GMS-2 to a grounded outlet.</td>
<td></td>
</tr>
<tr>
<td>Cable p/n 22-060002-01</td>
<td></td>
</tr>
<tr>
<td>Adapter p/n 22-060001-01</td>
<td></td>
</tr>
<tr>
<td>USB cable</td>
<td><img src="image" alt="USB Cable" /></td>
</tr>
<tr>
<td>Connects the GMS-2 to an external device (controller or computer) for high-speed data transfer and receiver configuration.</td>
<td></td>
</tr>
<tr>
<td>p/n 14-008081-01</td>
<td></td>
</tr>
</tbody>
</table>
GMS-2 Software

The GMS-2 comes with the following factory-installed software:

- **BTManager** – a utility that manages and controls the Bluetooth module inside the GMS-2. BTManager connects the GMS-2 and other Bluetooth-enabled devices. For more information, see “Connecting the GMS-2 and a Bluetooth Device” on page 3-3 and “Using the Bluetooth Manager” on page 5-1.

- **GMS Tools** – a utility that manages and controls the camera, compass, and GNSS settings. For more information, see “Surveying with the GMS-2 (Using GMS Tools)” on page 3-5 and “Using the Camera and Compass” on page 4-1.

![BT Manager and GMS Tools](image)
Optional Accessories

Table 1-2 gives a brief list of optional accessories that can be used with the GMS-2. Contact your dealer to purchase optional accessories.

<table>
<thead>
<tr>
<th>Accessory</th>
<th>Illustration</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>External GPS Antenna and Cable</strong></td>
<td></td>
</tr>
<tr>
<td>Connecting an external PG-A5 GPS antenna increases the range of the GMS-2.</td>
<td>![External GPS Antenna and Cable Illustration]</td>
</tr>
<tr>
<td>PG-A5 p/n 01-844201-07</td>
<td></td>
</tr>
<tr>
<td>Cable p/n 14-008079-01</td>
<td></td>
</tr>
<tr>
<td><strong>Serial Cable</strong></td>
<td></td>
</tr>
<tr>
<td>Connects the GMS-2 to an external device (controller or computer) for data transfer and receiver configuration.</td>
<td>![Serial Cable Illustration]</td>
</tr>
<tr>
<td>p/n 14-008080-01</td>
<td></td>
</tr>
<tr>
<td><strong>BR-1</strong></td>
<td></td>
</tr>
<tr>
<td>The BR-1 is a receiver that detects signals from local Beacon stations. When connected to the GMS-2, it provides correction data.</td>
<td>![BR-1 Illustration]</td>
</tr>
<tr>
<td>p/n 01-852001-01</td>
<td></td>
</tr>
<tr>
<td><strong>Lighter Adapter Cable</strong></td>
<td></td>
</tr>
<tr>
<td>Connects the GMS-2 to an automobile cigarette lighter for power supply</td>
<td>![Lighter Adapter Cable Illustration]</td>
</tr>
<tr>
<td>p/n 14-008148-01LF</td>
<td></td>
</tr>
</tbody>
</table>
### Optional Accessories

<table>
<thead>
<tr>
<th>Accessory</th>
<th>Illustration</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Serial Cable for Modem</strong></td>
<td></td>
</tr>
<tr>
<td>Connects the GMS-2 to an external modem.</td>
<td><img src="image1.png" alt="Serial Cable" /></td>
</tr>
<tr>
<td>p/n 14-008104-01LF</td>
<td></td>
</tr>
<tr>
<td><strong>Serial Cable for External Receiver</strong></td>
<td></td>
</tr>
<tr>
<td>Connects the GMS-2 to a Topcon GPS+ receiver.</td>
<td><img src="image2.png" alt="Serial Cable" /></td>
</tr>
<tr>
<td>p/n 14-008103-01LF</td>
<td></td>
</tr>
<tr>
<td><strong>Optional Software</strong></td>
<td><img src="image3.png" alt="Software" /></td>
</tr>
<tr>
<td>TopSURV and Field Tools for Arcpad are GIS surveying software that can enhance and expand typical surveys with GMS-2.</td>
<td></td>
</tr>
</tbody>
</table>
Option Authorization File (OAF)

Topcon Positioning Systems issues an Option Authorization File (OAF) to enable the specific options that customers purchase. An Option Authorization File allows customers to customize and configure the receiver according to particular needs, thus only purchasing those options needed.

Typically, all receivers ship with a temporary OAF that allows it to be used for a predetermined period of time. When the receiver is purchased, a new OAF permanently activates the desired, purchased options. Receiver options remain intact when clearing the NVRAM or resetting the receiver.

The OAF enables the following functions. For a complete list of available options and details, visit the TPS website or consult your TPS dealer.

- Type of signal (standard GPS L1; optional GLONASS L1)
- RTCM Input/Output (standard)
- Advanced multipath reduction (standard)
- Wide Area Augmentation System (WAAS) (standard)
Preparing the GMS-2 for Use

Before using the GMS-2, make sure the battery is fully charged. If using other software to survey with (such as, TopSURV), install it in the office. An optional SD card should also be inserted before beginning to survey.

Attaching the Hand Strap

The hand strap provides a comfortable, secure support for using the GMS-2 on the job. The velcro extender at the bottom of the strap allows for comfortable re-adjustment of the strap for larger or smaller hands.

To attach the hand strap, thread the bottom end of the strap through the hook on the bottom of the GMS-2 and press the velcro together. Gently stretch the strap and hook the top end onto the hand strap hook on the back of the GMS-2.

When replacing the battery, unhook the top end of the strap to access the battery door latch.
Powering the GMS-2

The GMS-2 uses a BT-62Q or BT-66Q battery for its primary power source. When using the GMS-2 for GPS activities, the battery will last up to seven hours. The battery will last up to fifty hours during continuous standby use (that is, no GPS usage, the display LED is off, and the touch screen is not being used). A backup coin battery and rechargeable battery back up the GPS and clock settings. An internal, rechargeable battery backs up RAM data for Windows CE.

Charging the Battery

The AC/DC converter provides power to the GMS-2 and charges the primary battery. Note that using the GMS-2 while charging increases the charge time. The battery will be fully charged in approximately seven hours.

To charge the battery using the converter (Figure 2-2 on page 2-3):

1. Plug the connector into the power port of the GMS-2.
2. Plug the converter into a grounded outlet.
   The battery will be fully charged after about six hours.

The charging LED indicates the level of charge in the battery:

- Green – battery has a full charge.
- Red – battery is charging.
- Red blink – charging error.
Powering the GMS-2

Figure 2-2. Charging the Battery in the GMS-2

To charge the battery using the optional charger (Figure 2-3):

1. Remove the battery from the GMS-2 (see “Installing the Battery” on page 2-4 for details), and slide it onto the charger.
2. Plug the charger into a grounded outlet.

Figure 2-3. Charging the Battery in the Charger
Preparing the GMS-2 for Use

**Charging and Battery Storage Notes**

To keep the battery properly charged, maintained, and stored, do the following:

- Only recharge the battery at room temperature, approximately 50°F to 104°F (10°C to 40°C). Charging at a high temperature increases the time it takes to charge the battery.
- Always check the battery charge before using the GMS-2. The battery will discharge during storage.
- Charge a stored battery every 7 days. Allowing a battery to become discharged can reduce the overall performance of the battery and charge efficiency.
- Be aware that the charger may become somewhat heated while charging the GMS-2.

**Installing the Battery**

The rechargeable battery can be charged using either the power port (see “Charging the Battery” on page 2-2) or the optional charger.

**To remove/replace the battery (Figure 2-4) do the following:**

1. If needed, unhook the top of the strap from the GMS-2.
2. Open the battery cover, and pop out the primary battery. The GMS-2 automatically turns off when the battery cover is opened.
3. Replace the battery with a fully charged one, snapping it into place.
4. Close the battery cover, and replace the hand strap.

If the battery cover does not close, rotate the battery 180° to snap it into place.
Replacing the Backup Battery

The backup battery ensures GPS and clock settings are saved when the primary battery and internal rechargeable battery are depleted. Under normal conditions, the backup battery lasts two to three years.

The Windows CE RAM has a separate backup, rechargeable battery. This battery will power the RAM for five minutes after removing the primary battery.

The backup battery is a CR2032 coin battery that can be purchased at many general retailers. You will need Phillips-head and flat-head screwdrivers to replace the backup battery. Follow these steps to replace the backup battery (Figure 2-5).

1. If needed, back up data on the internal CF card. See “Backing up Windows CE RAM Data” on page 3-9 for details.
2. Open the battery cover and remove the primary battery.
3. Using a Phillips-head screwdriver, remove the coin battery cover.
4. Using a flat-head screwdriver, insert the tip of the screwdriver in the slot to the left of the coin battery. Gently push the coin battery
Preparing the GMS-2 for Use

to the right to pop it out of the holder. Repeat these steps on the left side of the holder to remove the coin battery.

---

**CAUTION**

Replace the battery within a couple of minutes to prevent data loss.

5. Insert the new coin battery, plus side up, into the holder. Slide the coin battery under the tabs and gently push into place.

6. Replace the coin battery cover and screw.

---

Figure 2-5. Replacing the Coin Battery
Starting the GMS-2

To start the GMS-2, briefly press the power button. The touch screen lights up and the GMS-2 splash screen displays while the system loads, then the Microsoft CE desktop displays.

![Press Power to Start the GMS-2](image)

The touch screen will need to be calibrated when first starting the GMS-2 or after a hard reset. The configuration function automatically starts and is simple to complete.

1. Using the stylus, tap the center target.
2. Tap the corner targets.
3. Press the Enter key.

![Calibrate the Touch Screen](image)
Installing Software

The GMS-2 runs standard Microsoft® CE operating system and applications. When installing other software applications onto the GMS-2, Microsoft ActiveSync is required. The following software may be useful for taking full advantage of the integrated features found in the GMS-2 controller/receiver.

- TopPAD – field data collection software used on a hand-held controller for GIS surveys. TopPAD is structured to provide the surveyor with capture and update functions for geographical data in a wide range of GIS-related applications.
- TopSURV – full-featured data collection software used on a hand-held controller. TopSURV is structured into several modules to provide scalable, cost effective functionality for a variety of uses. Use TopSURV GIS to capture and update functions for geographical data in a wide range of GIS-related applications.
- CE-CDU – a utility that configures GPS and DGPS receivers connected to a hand-held controller.

Installing software onto the GMS-2 requires a connection to a computer that contains the software. Software is first downloaded onto a desktop/laptop computer, then installed onto a connected controller via Microsoft ActiveSync.

Refer to the corresponding manual for specific instructions to install software onto the GMS-2.

**Installing Microsoft ActiveSync** ActiveSync is available for free from the Microsoft website (www.microsoft.com) and must be installed on the computer before installing software onto the GMS-2.
Installing an Optional SD Card

SD (secure digital) cards can be purchased at a local computer supply store. When inserted into the GMS-2, an SD card provides additional data storage, as well as data transfer.

1. Open the SD card slot door.
2. Gently insert an SD card into the slot.
3. Close the SD card slot door.

Figure 2-8. Insert SD Card
Preparing the GMS-2 for Use

Notes:

________________________________________________________________________

________________________________________________________________________

________________________________________________________________________

________________________________________________________________________

________________________________________________________________________

________________________________________________________________________

________________________________________________________________________

________________________________________________________________________

________________________________________________________________________

________________________________________________________________________

________________________________________________________________________

________________________________________________________________________
Chapter 3

Using the GMS-2

The GMS-2 can be used as a stand-alone, L1 GPS+ receiver, or with other devices. When installing software or performing file transfers, the USB cable or Bluetooth module connects the GMS-2 to a computer for in-office processing. For increased surveying accuracy, a connected external GPS antenna or external receiver allows other signals (such as L2 or Beacon) to be recorded.

Connecting the GMS-2 with Other Devices

The GMS-2 provides direct connection to devices with serial or USB port, devices that support Bluetooth wireless technology, an external GPS antenna (PG-A5), and receivers that provide correction information. The various devices are optional and can be purchased from your local Topcon dealer or at a commercial retail store for commercially sold products (such as the SD card).

Figure 3-1. GMS-2 System Connections

[Diagram showing system connections]
Using the GMS-2

Connecting the GMS-2 and a Computer

Connecting the GMS-2 and a computer allows you to install software onto the controller and upload data from the controller to a computer.

When connecting the GMS-2 and a computer, Microsoft ActiveSync must be installed on the computer. See “Installing Microsoft ActiveSync” on page 2-8 for details.

1. Connect the GMS-2 and the computer using the USB or serial cable, or Bluetooth wireless technology.

   ![Connecting GMS-2 and Computer (USB) Using Cable](image)

   **Figure 3-2. Connect GMS-2 and Computer (USB) Using Cable**

2. When ActiveSync on the computer prompts to set up a partnership, select No, and click Next.

3. Once the connection has been established, click the Explorer icon on the ActiveSync screen to view data on the GMS-2 compact flash card.

   - For a Bluetooth connection, see “Connecting the GMS-2 and a Bluetooth Device” on page 3-3 for details.
Connecting the GMS-2 and a Bluetooth Device

The Bluetooth Devices screen displays the List of Favorite Devices, so you can quickly and easily connect with a saved device. If the device you are looking for is not listed, then you can search for up to nine other Bluetooth-enabled devices within range. Make sure the devices you are searching for are discoverable.

To connect with a paired device:

1. From the Bluetooth Devices screen, highlight a device, and tap Select.

2. If you cannot find a saved device on this screen, then tap Find. An hourglass appears while BTManager searches the List of Favorite Devices and then searches for up to nine nearby Bluetooth-enabled devices.
Using the GMS-2

3. After the devices are found, you can:
   - Tap Refresh to search again.
   - Highlight a device, and check the Save selection for future use check box. This saves the device to the List of Favorite Devices.

If an error message displays upon trying to connect, then it usually means that the security settings of the remote device do not correspond to the security settings of the GMS-2.
To correct this, make sure the PIN, Authentication, and Encryption check boxes on the My Bluetooth Device screen correspond with the security settings of the remote device.

For more information about troubleshooting error messages, see “Bluetooth Problems” on page 6-6.

For more information about connecting devices and using Bluetooth Manager, see “Using the Bluetooth Manager” on page 5-1.

Surveying with the GMS-2 (Using GMS Tools)

The GMS-2 can be used in many surveying situations. From GIS surveying to data collection on a construction jobsite, the GMS-2 provides an integrated solution for all your needs.

Simple surveying (data collection) with the GMS-2 can be handled with the on-board GMS Tools software. Other surveys may require an external GPS antenna and/or a Beacon receiver to acquire GPS signals or correction data for better position accuracy.

Surveying with the GMS-2

For more information on GMS Tools, see “GMS Tools” on page 4-1.

1. Complete any required pre-survey steps as described in Chapter 2.
2. Open GMS Tools, and tap the GNSS tab.
3. Check the antenna, interval, and mask settings. For typical surveys, the antenna should be Internal.
4. Tap Logging.
5. Enter a file name in which to log data, and tap OK to begin saving position information.
Surveying with the GMS-2 and an External Antenna

1. Complete any required pre-survey steps as described in Chapter 2.
2. Setup the external antenna according to its documentation.
3. Using the external antenna cable, connect the GMS-2 and external antenna.
4. Open GMS Tools, and tap the GNSS tab.
5. Select External for the antenna setting. Edit the interval and elevation mask settings as needed.

6. Tap Logging.
7. Enter a file name in which to log data, and tap OK to begin saving position information.
Surveying with the GMS-2 and a Beacon Receiver

1. Complete any required pre-survey steps as described in Chapter 2.
2. Setup the Beacon receiver according to its documentation.
3. Using BTManager, connect the GMS-2 and GPS receiver as described in “Connecting the GMS-2 and a Bluetooth Device” on page 3-3. In BTManager, the BR-1 would be considered an “Uncategorized” device.

4. Configure the GMS-2 for data collection as described in the corresponding software manual.

Connect GMS-2 and BR-1 Receiver via Bluetooth

**Figure 3-7. GMS-2 and BR-1 Setup**

4. Configure the GMS-2 for data collection as described in the corresponding software manual.

**Notice**

Ensure the survey configuration is for an external receiver.

For example, if using TopPAD as the data collection software, refer to the *TopPAD Reference Manual*.

5. Via the data collection software, begin logging data.
6. When you reach a location to record a point, pause and press the **Enter** button on the GMS-2. Wait until the point is recorded before moving to the next location.
Surveying with the GMS-2 and an External GPS Receiver

This setup uses Bluetooth wireless technology for communication between the GMS-2 and a GPS receiver.

1. Complete any required pre-survey steps as described in Chapter 2.
2. Setup the external GPS receiver according to its documentation.
3. Using BTManager, connect the GMS-2 and GPS receiver as described in “Connecting the GMS-2 and a Bluetooth Device” on page 3-3. In BTManager, the BR-1 would be considered an “Uncategorized” device.

4. Configure the GMS-2 for data collection as described in the corresponding software manual.

   Ensure the survey configuration is for an external receiver.

For example, if using TopSURV as the data collection software, refer to the *TopSURV Reference Manual*.

5. Via the data collection software, begin logging data.
6. When you reach a location to record a point, pause and press the *Ent (Enter)* button on the GMS-2. Wait until the point is recorded before moving to the next location.
Back up Windows CE RAM Data

The Windows CE RAM data stores such items as collected/saved data, registry information, and installed programs. Performing a regular backup of this data ensures efficient and continued use of the GMS-2. RAM data will be lost in the following situations:

- Losing battery power through draining the battery or removing the battery.
- Performing a hardware reset.
- Upgrading the operating system.

When backing up RAM data, data is stored on the internal flash memory in a “Backup” directory.

1. On the main screen of the GMS-2, tap Start ▶ Settings ▶ Control Panel ▶ System ▶ Backup.
2. On the RAM Backup tab, tap RAM data backup. The backup to the Flash memory will begin.
   - If desired, turn on Ram data will be backed up before suspension to automatically back up RAM data as the GMS-2 shuts down.
   - Leave Data restoration after hard reset on to recover data after a hardware reset. Data is restored after a hard reset and power cycle.
     If desired, turn it off (data will not be restored).
3. When the backup completes, tap OK.

Note the following conditions of a backup and restoration cycle:

- If the Flash memory does not have enough space to store a RAM backup, the backup will be incomplete.
- After upgrading the OS, some items may not be fully restored.
Using the GMS-2

Notes:

__________________________________________________________________________________

__________________________________________________________________________________

__________________________________________________________________________________

__________________________________________________________________________________

__________________________________________________________________________________

__________________________________________________________________________________

__________________________________________________________________________________

__________________________________________________________________________________

__________________________________________________________________________________

__________________________________________________________________________________

__________________________________________________________________________________

__________________________________________________________________________________

__________________________________________________________________________________

__________________________________________________________________________________

__________________________________________________________________________________

__________________________________________________________________________________

__________________________________________________________________________________

__________________________________________________________________________________

__________________________________________________________________________________
Chapter 4

Using the Camera and Compass

GMS Tools

GMS Tools is a simple utility that manages the camera, compass, and receiver board settings in the GMS-2.

Getting Acquainted

Table 4-1 summarizes the screens and settings in GMS Tools.

<table>
<thead>
<tr>
<th>Description</th>
<th>Screen</th>
</tr>
</thead>
<tbody>
<tr>
<td>Camera</td>
<td><img src="image" alt="Camera Screen" /></td>
</tr>
</tbody>
</table>

The Camera tab defines settings for the integrated camera, as well as captures and saves images.
Using the Camera and Compass

### Table 4-1. GMS Tools Screens (Continued)

<table>
<thead>
<tr>
<th>Description</th>
<th>Screen</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Compass</strong></td>
<td><img src="image1.png" alt="Compass Screen" /></td>
</tr>
<tr>
<td>The Compass tab displays the current North/South direction. The angle to North displays the pitch and roll of the unit and calibrates the compass.</td>
<td></td>
</tr>
<tr>
<td><strong>GNSS</strong></td>
<td><img src="image2.png" alt="GNSS Screen" /></td>
</tr>
<tr>
<td>The GNSS tab selects the antenna (internal or external), logging interval, and elevation mask. This tab also displays current position and satellite information.</td>
<td></td>
</tr>
<tr>
<td><strong>Append</strong></td>
<td><img src="image3.png" alt="Append Screen" /></td>
</tr>
<tr>
<td>The Append tab allows you to clear the NVRAM and turn on the internal GPS power board. For more information, see “Clearing the NVRAM” on page 4-9.</td>
<td></td>
</tr>
</tbody>
</table>
Working with GMS Tools

When first opening GMS Tools or after a reset, all settings will be at the default selections. Typical camera, compass, and GNSS settings only need to be configured once. Occasionally, individual uses may require different settings. GMS Tools takes and saves pictures, as well as saves logged satellite information.

Using the Camera

The Camera tab (Figure 4-1 on page 4-4) defines certain picture qualities for captured images, including the brightness/sharpness and time of day. This tab also takes and previews pictures, as well as saves the picture to the internal memory. A thumbnail row shows the last three pictures taken (but not necessarily saved).

Adjust camera settings using the following selections:

- Brightness – drag the slider right/left to increase/decrease the brightness of the captured image. Settings are from -5 to +5.
- Sharpness – drag the slider right/left to increase/decrease the sharpness of the captured images. Settings are from 0 to +6.
Using the Camera and Compass

- Time of day – select “day” for images captured taken in bright light, “night” for images captured in low light, or “auto” to have the setting automatically detect the ambient light.
- Capture size – select the size of the image to capture, in bits.

![Figure 4-1. Adjust Camera Settings](image)

**To take a picture:**

1. Aim the camera at the desired object(s), using the finder/review pane to frame the image.
2. Press **Capture**.
3. To save the picture, press **Yes**.
4. Enter a file name and navigate to the location in which to save the picture. Press **OK**.
By default, captured images are saved using the ID of the capture size (SXGA, VGA, etc.) and an incrementing number.

Using the Compass
The Compass tab displays the current direction, roll, and pitch of the GMS-2. This tab also calibrates the compass.

- Pointer – North (red portion of pointer) and South (white portion of pointer) directions.
- Angle – the angle (azimuth) from North, in degrees.
- Tilt – the roll and pitch, from level, in degrees minutes.

The compass may need to be calibrated if you notice that its precision is no longer accurate.
Using the Camera and Compass

When calibrating the compass, the new calibration is only used until the GMS-2 is turned off. When the unit is turned on, the default calibration will be used.

1. To calibrate the compass, tap **Calibration** on the Compass tab.
2. Place the unit horizontally on a flat surface, and tap **Start** at the confirmation (Figure 4-4 on page 4-6).

3. Rotate the unit 360° twice, in the same direction as the circling red dot on-screen. Tap **End**.

---

![Figure 4-4. Begin Compass Calibration](image1)

![Figure 4-5. Calibrating the Compass](image2)
Viewing GNSS Information and Logging Data

The GNSS tab displays current position and satellite information, as well as applies certain settings to the internal GPS receiver.

- Position information pane – displays the observation mode (No Solution, Autonomous, or Code Differential), the number of satellites being tracked, current time, current position (Lat/Lon/Alt), and current PDOP.
- Antenna – selects the type of GPS antenna used, either the internal GMS-2 antenna or an external antenna.
- Interval – the time interval for recording data. For example, selecting 10 will record a position every 10 minutes.
- Elevation – the elevation mask for recording data from satellites above the selected elevation (angle). For example, selecting 10 will have GMS Tools only record data from satellites that are 10° above the horizon.

To log data, tap Logging on the GNSS tab of GMS Tools. Enter a name for the file in which to log data and tap OK to begin saving position information.
To stop logging data, tap **Stop**.

![Figure 4-7. Logging Data](image)

**Keeping Internal GNSS Power On**

The internal GNSS board powers on automatically when using Topcon software. If you are using software other than Topcon’s, then you need to manually turn on the GNSS board.

To turn on the GNSS board:

1. Open GMS Tools, and tap the **append** tab.

![Figure 4-8. GMS Tools - Append Tab](image)

2. Enable the **Keep power on** check box.

The GNSS receiver board will continue to draw power, even if it is not being used.
Clearing the NVRAM

The receiver’s Non-Volatile Random Access Memory (NVRAM) holds data required for satellite tracking, such as ephemeris data and receiver position. The NVRAM also keeps the current receiver’s settings, such as active antenna input, elevation masks and recording interval, and information about the receiver’s internal file system.

Even though clearing the NVRAM is not a common (nor normally a recommended) operation, there are times when clearing the NVRAM can eliminate communication or tracking problems. Clearing the NVRAM in your receiver can be interpreted as a “soft boot” in your computer.

After clearing the NVRAM, the receiver requires time to collect new ephemerides and almanacs (around 15 minutes).

Clearing the NVRAM of your receiver will not delete any files already recorded in your receiver’s memory; however, it will reset your receiver to factory default values.

In addition, the NVRAM keeps information about the receiver file system. Note that after clearing the NVRAM, the receiver’s STAT LED flashes orange for a few seconds, indicating that the receiver is scanning and checking the file system.

To clear the NVRAM:

1. Open GMS Tools, and tap the **append** tab.
Using the Camera and Compass

2. Press **NVRAM Clear**.
3. Press **Yes** to confirm.
Chapter 5

Using the Bluetooth Manager

The BTManager utility controls the GMS-2 Bluetooth module.

Getting Started

To start BTManager:

1. Turn on the GMS-2.
2. Tap the Bluetooth icon in the system tray, and select Bluetooth Manager from the pop-up menu.

3. If the Bluetooth transmitter is switched off (the Bluetooth icon is gray), select Turn Transmitter On to turn on Bluetooth.
Using the Bluetooth Manager

Getting Acquainted

Table 1-1 summarizes the screens and settings in BTManager.

### Table 5-1. BTManager Screens

<table>
<thead>
<tr>
<th>Description</th>
<th>Screen</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Type of devices to detect</strong></td>
<td><img src="image1.png" alt="Screen 1" /></td>
</tr>
<tr>
<td>This screen displays types of devices to discover. Once a device type is selected, the <em>Discovery Wizard</em> searches for those devices when you tap <strong>Next</strong>.</td>
<td></td>
</tr>
</tbody>
</table>

| **Device List** | ![Screen 2](image2.png) |
| This screen displays all discovered devices of a selected type. From this list, you can choose a device to add to your *List of Favorite Devices* by tapping **Next**. |
### List of Favorite Devices

This screen displays your preferred Bluetooth-enabled devices. You can use the Device Discovery wizard option in the Tools menu or the Bluetooth Devices screen to search for Bluetooth-enabled devices within range and save them to this list for future connections.

![List of Favorite Devices Screenshot](image)

### My Bluetooth Device

This screen displays the internal GMS-2 Bluetooth module information. On this screen, you can set your preferences and choose how to connect with other devices.

![My Bluetooth Device Screenshot](image)
Table 5-1. BTManager Screens (Continued)

<table>
<thead>
<tr>
<th>Description</th>
<th>Screen</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Pairing</strong></td>
<td></td>
</tr>
<tr>
<td>This screen displays when the GMS-2 is in pairing mode, and it accepts a pairing request initiated by a remote device.</td>
<td></td>
</tr>
<tr>
<td><img src="image" alt="Pairing Screen" /></td>
<td></td>
</tr>
</tbody>
</table>

| **Bluetooth Devices** |        |
| This screen displays the List of Favorite Devices. If you do not see a device that you are looking for on this list, then you can tap **Find** to search for it. |
| ![Bluetooth Devices Screen](image) |
Working with Bluetooth Manager

Before the GMS-2 can pair with another Bluetooth-enabled device, it must discover which devices are available within your coverage area. You can use the Device Discovery wizard to search for any Bluetooth-enabled device within range or a particular type of device, and then save the device(s) to your Bluetooth Devices folder for future connections.

Table 5-1. BTManager Screens (Continued)

<table>
<thead>
<tr>
<th>Description</th>
<th>Screen</th>
</tr>
</thead>
<tbody>
<tr>
<td>About BTManager</td>
<td><img src="image" alt="About BTManager" /></td>
</tr>
</tbody>
</table>

About BTManager

This screen displays version and copyright information for BTManager.
Using the Bluetooth Manager

Discovering Devices

To discover other Bluetooth-enabled devices within your coverage area.

1. Tap Tools ➤ Device Discovery.

   The Discovery Wizard appears (Figure 5-3).

   Figure 5-3. Discovery Wizard
2. Tap **Next** to display a list of device types.

![Device Categories](image)

**Figure 5-4. Device Categories**

3. Choose a type of device to discover, and tap **Next**.

The *Discovery Wizard* searches for Bluetooth-enabled devices in your coverage area and displays the icons of the devices it detects on the *Device List*.

As device names and addresses are retrieved, the *Device List* updates with detailed information (Figure 5-5 on page 5-8).

Once the *Device List* is populated, you can add any device from this list to the *List of Favorite Devices*.

---

**NOTICE**

Only up to nine devices can be discovered at a time. If you select the “Any Bluetooth device” option and the device you want is not displayed in the *Device List* (Figure 5-5 on page 5-8), then select a more specific category to narrow the range of the devices you want to discover.
Using the Bluetooth Manager

Adding to the List of Favorite Devices

The Device List displays all discovered Bluetooth-enabled devices in your coverage area.

To add a device from the Device List to the List of Favorite Devices:

1. Select a device, and tap Next. You can choose more than one device.

![Device List](image)

Figure 5-5. Select Device(s)

A confirmation message appears when the devices are successfully added to the List of Favorite Devices.
2. Tap **Finish** to exit the *Wizard* and display the *List of Favorite Devices*.

![Finish dialog box](image)

**Figure 5-6. Devices Added**

To save time, you can save Bluetooth-enabled devices on the *List of Favorite Devices*, so you do not have to rediscover it. You can view devices by icon and name or by name and address.

![List of Favorite Devices](image)

**Figure 5-7. List of Favorite Devices**
Using the Bluetooth Manager

To display the list of devices by name and address, tap View » Details.

![Device List Screenshot]

**Figure 5-8. Details on Bluetooth Devices**

**Viewing Device Properties**

To view the properties of a device, select the device in the *List of Favorite Devices* (Figure 5-7 on page 5-9), and tap Device » Properties.

![Device Properties Screenshot]

**Figure 5-9. Bluetooth Device Properties**

The *Bluetooth Device Properties* screen displays major and minor class identifiers, the name, and address of the selected device.
Deleting a Device from the List

To delete a device from the List of Favorite Devices:

1. Select the device, and tap Device ▶ Delete.
   A confirmation message appears.

2. Tap Yes to delete the device.

Figure 5-10. Deleting a Device

Setting Device Preferences

The My Bluetooth Device screen (Figure 5-11 on page 5-12) displays information about the internal GMS-2 Bluetooth module. The preferences you set on this screen determine how your GMS-2 pairs with and connects to remote devices.
Using the Bluetooth Manager

To access the My Bluetooth Device screen, tap **Device ➤ My Bluetooth Device**.

![My Bluetooth Device](image)

*Figure 5-11. My Bluetooth Device*

*My Bluetooth Device* always displays the following information:

- **Class** (major and minor)
- **Name** (Other devices use this name to identify the GMS-2.)
- **Address**

This screen also allows you to enable the following accessibility options:

- **Discoverable**: allows other devices within range to find the GMS-2.
  - It is not necessary to enable this option when initiating a connection from the GMS-2 and for most dial-up networking.
  - When not in use, disable this option manually to save power.
- **Connectable**: allows other devices within range to connect to the GMS-2.
  - It is not necessary to enable this option when initiating a connection from the GMS-2 and for most dial-up networking.
- **Authentication**: authenticates the identity of other devices. Select this option if you want to require a passkey to connect with another Bluetooth enabled device. If either or both devices use
authentication, then a passkey must be entered. Once Authentication is selected, the Passkey can be edited.

- **Encryption:** secures all data sent over Bluetooth.

Typically, Topcon Bluetooth-enabled GPS receivers do not require a PIN upon connection. If it is necessary, however, the PIN (up to 16 characters) can be set for a Topcon GPS receiver by BTCONF, the Topcon Bluetooth module configuration program.

Topcon Total Stations require a PIN on connection. Typically, the PIN value is set to “1111”. This value can be changed.

- **Service Mode:** BTManager allows the GMS-2 to connect with other Bluetooth-enabled devices using serial port or dial-up services. The connecting device needs to support the service selected:
  - SPP (Serial Port Profile): provides serial port connection with peripheral Bluetooth-enabled devices, including GPS receivers which normally do not require authentication.
  - DUN (Dial-up Networking Profile): provides a standard to access dial-up services over Bluetooth. The most common scenario is using a mobile phone as a modem.

### Pairing Bluetooth Devices

The Pairing Mode allows a remote Bluetooth-enabled device to initiate a request to pair with the GMS-2. If the Pairing Mode option is activated, then the GMS-2 switches to Pairing Mode for two minutes. During this two-minute period, any remote device can attempt to pair with it.

The GMS-2 accepts the first pairing request if the security settings on the remote device match the GMS-2 security settings. You do not need to activate the Pairing Mode option if the GMS-2 initiates the pairing request.
To activate Pairing Mode, tap **Device ▶ Pairing Enable**.

The **Pairing** screen appears, displaying how much time is left to pair with another device.
Once the two minutes expires, a message appears stating if the pairing succeeded or failed.

![Pairing Confirmation](image)

**Figure 5-14. Pairing Confirmation**

For information about connecting Bluetooth Devices, see “Connecting the GMS-2 and a Bluetooth Device” on page 3-3.

For information about troubleshooting Bluetooth error messages, see “Bluetooth Problems” on page 6-6.
Using the Bluetooth Manager

Notes:

________________________________________________________________________

________________________________________________________________________

________________________________________________________________________

________________________________________________________________________

________________________________________________________________________

________________________________________________________________________

________________________________________________________________________

________________________________________________________________________

________________________________________________________________________

________________________________________________________________________

________________________________________________________________________

________________________________________________________________________

________________________________________________________________________

________________________________________________________________________
Troubleshooting

This chapter will help you diagnose and solve some common problems you may encounter with the GMS-2.

Do not attempt to repair equipment yourself. Doing so will void your warranty and may damage the hardware.

Check This First!

Before contacting Topcon support, check the following:

- If software is unresponsive, perform a software reset. See “Resetting the Software” on page 6-3 for details.
- Check all external connections (cable and wireless).
- Check all power sources for drained batteries or incorrectly connected batteries/cables.
- Check that the most current software is downloaded onto the GMS-2, and the most current firmware is loaded into the receiver. Check the TPS website (www.topconpositioning.com) for the latest updates.

Then, try the following:

- Reset the hardware. See “Resetting the Hardware” on page 6-4.
- Restore default settings for the Bluetooth module and GPS+ receiver. See “Restoring Bluetooth Module Defaults” on page 6-3 for details.
- Clear the SDRAM (remove the battery).

If the problem persists, see the following sections for other solutions.
Troubleshooting Quick List

To reset the software, see “Resetting the Software” on page 6-3.
To reset the hardware, see “Resetting the Hardware” on page 6-4.

For power problems:
   If “The GMS-2 does not power up” see page 6-5.

For general GMS-2 problems:
   If “The GMS-2 is not receiving data (corrections) from an external receiver” see page 6-5.
   If “Installed software and other data has been erased” see page 6-6.

For Bluetooth problems:
   If “The GMS-2 is no longer connected via Bluetooth” see page 6-6.
   If “Cannot connect to another Bluetooth-enabled device” see page 6-6.
Resetting the Software

Only perform a software reset in the following instances:

- To quit all active applications.
- After installing new applications.
- When an application is unresponsive.

To perform a software reset, use the stylus to push in the software reset button (Figure 6-1).

Restoring Bluetooth Module Defaults

If the Bluetooth module is not performing as expected, try returning the settings to the defaults.

For the Bluetooth module, tap Reset on the Accessibility tab in BTManager.
Troubleshooting

Resetting the Hardware

Only perform a hardware reset when the GMS-2 has become completely unresponsive. A hardware reset will revert all settings to defaults and erase all RAM data.

![Figure 6-2. Resetting the Hardware]

**WARNING**

A hardware reset will erase all RAM data and applications. Regular backups will ensure RAM data and applications can be restored.

To perform a hardware reset, simultaneously hold the ENT and ESC buttons while pushing the software reset button for two or more seconds (Figure 6-2). The unit will power off.

Completely draining the battery performs the same function as a hardware reset.
Charging/Powering Problems

The GMS-2 does not power up

- The batteries may be discharged.
  - Connect the GMS-2 to a grounded outlet to charge the battery. See “Charging the Battery” on page 2-2.
  - Insert a fully charged battery. See “Installing the Battery” on page 2-4.
- The charging cable may be disconnected or damaged.
  - Check that the cable is securely connected and undamaged.
- The GMS-2 may have a defective charger or defective internal battery.
  - If, after changing the battery or connecting an external power source, the GMS-2 still does not power up, contact TPS Customer Support for advice. See “Obtaining Technical Support” on page 6-8.

GMS-2 Problems

The following are some of the most commonly encountered problems with the GMS-2.

The GMS-2 is not receiving data (corrections) from an external receiver

- Check the Bluetooth LED. The LED will be blue when a connection has been established.
- Check if BTManager was closed manually.
  - If BTManager was closed manually (tapping the close button on the title bar), the port used for communication between the GMS-2 and an external device will be disconnected from the Bluetooth module.
    1. Open BTManager and check the Bluetooth Indicator:
Troubleshooting

- Red – no connection between BTManager and the Bluetooth module.
- White – a connection between BTManager and the Bluetooth module has been established.
- Green – via a serial port, a connection between the GMS-2 and an external Bluetooth-enabled device has been established.

2. If needed, select the device to connect to and tap Connect.

For more information, see “Connecting the GMS-2 and a Bluetooth Device” on page 3-3.

Installed software and other data has been erased

⇒ The battery in the GMS-2 has been completely drained or a hardware reset has been performed.

Reinstall all software. See “Installing Software” on page 2-8 and the software manual for details.

Restore data backed up from the CF card.

Bluetooth Problems

The following are some of the most commonly encountered problems with the GMS-2.

The GMS-2 is no longer connected via Bluetooth

⇒ Check the Bluetooth LED. The LED will be blue when a connection has been established.

For information about connecting Bluetooth devices, see “Connecting the GMS-2 and a Bluetooth Device” on page 3-3

Cannot connect to another Bluetooth-enabled device

⇒ If you encounter an error message while pairing with other Bluetooth-enabled devices, use Table 6-1 to learn which actions to take to correct the error.
Table 6-1. Most Common Errors

<table>
<thead>
<tr>
<th>Error Message</th>
<th>Action to Take</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>GMS-2 Bluetooth Error</strong>&lt;br&gt;Confirm PIN on both the master and the slave. Make sure the device is connectable and discoverable. Make sure both sides have issued the appropriate pairing command. &lt;br&gt;OK</td>
<td>1. The PIN you entered on the My Bluetooth Device page does not match the PIN you entered on the remote device. Make sure the GMS-2 and the remote device use the same PIN. &lt;br&gt;2. The Connectable setting was not selected on the remote device or the device was switched off. Make sure the remote device is on and the Connectable check box on the My Bluetooth Device page is selected. &lt;br&gt;3. The remote Bluetooth device is already being used and it does not support simultaneous Bluetooth connections. Close the connection between the remote device and other device.</td>
</tr>
<tr>
<td><strong>GMS-2 BT error</strong>&lt;br&gt;Confirming the condition (the connectable, security) of other devices.</td>
<td>Set the same parameters for authentication and encryption on both devices and try to connect again.</td>
</tr>
<tr>
<td><strong>WireZ error</strong>&lt;br&gt;The operation returned because the timeout period expired. &lt;br&gt;OK</td>
<td>1. The remote device does not support the Service Mode you selected. On the My Bluetooth Device page, select another Service Mode. &lt;br&gt;2. There is a critical problem with the Bluetooth module. Clear the NVRAM of the GMS-2. For more information, see “Clearing the NVRAM” on page 4-9.</td>
</tr>
</tbody>
</table>
Troubleshooting

Table 6-1. Most Common Errors (Continued)

<table>
<thead>
<tr>
<th>Error Message</th>
<th>Action to Take</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image1" alt="Image" /></td>
<td>Another application is using the GMS-2 COM2 serial port. Close the application or release the port. The COM2 serial port is reserved for the Bluetooth Manager.</td>
</tr>
<tr>
<td><img src="image2" alt="Image" /></td>
<td>Port B of the GMS-2 GPS receiver, through which the Bluetooth Manager connects to the Bluetooth module, is not in command mode. Change Port B input mode back to command mode or clear the GMS-2 NVRAM. See the Operator’s Manual for more information.</td>
</tr>
</tbody>
</table>

Obtaining Technical Support

If the troubleshooting hints and tips in this Operator’s Manual fail to remedy the problem, contact TPS Customer Support.

Before contacting TPS Customer support about any problems with the unit, see “Check This First!” on page 6-1 for some solutions that may fix the issue.

Phone

To contact TPS Customer Support by phone, call:

1-866-4TOPCON (1-866-486-7266)
Monday through Friday
5 am to 5 pm, Pacific Time
E-mail

To contact TPS Customer Support via e-mail, use one of the following electronic mail addresses (Table 6-2).

**Table 6-2. Technical Support E-mail**

<table>
<thead>
<tr>
<th>For Questions Related To...</th>
<th>Use...</th>
</tr>
</thead>
<tbody>
<tr>
<td>Hardware (receivers, antennas, firmware)</td>
<td><a href="mailto:hardware@topcon.com">hardware@topcon.com</a></td>
</tr>
<tr>
<td>GPS+ and 3DMC</td>
<td><a href="mailto:psg@topcon.com">psg@topcon.com</a></td>
</tr>
<tr>
<td>OAF</td>
<td><a href="mailto:options@topcon.com">options@topcon.com</a></td>
</tr>
<tr>
<td>RTK</td>
<td><a href="mailto:rtk@topcon.com">rtk@topcon.com</a></td>
</tr>
<tr>
<td>PC-CDU</td>
<td><a href="mailto:pccd@topcon.com">pccd@topcon.com</a></td>
</tr>
<tr>
<td>If in doubt...</td>
<td><a href="mailto:support@topcon.com">support@topcon.com</a></td>
</tr>
</tbody>
</table>

For quick and effective support, provide a detailed description of the problem as described below.

When e-mailing TPS customer support, provide the following information for better, faster service:

1. The device’s model and configuration settings.
   - In CE-CDU, click **File > Receiver Info** and click **Save to file**. Enter a name for the file and save it to your computer. Attach this file to the email.
2. The serial number of the device (located under the battery).
3. The system/hardware specifications for the device(s); such as, operating system and version, memory and storage capacity, processor speed, etc.
4. The symptoms and/or error codes/messages that precede and follow the problem.
5. The activities being tried when the problem occurs. If possible, include the exact steps being taken up to when the error message or other problem occurs.
6. How regularly the problem occurs.
Troubleshooting

Generally, a customer support representative will reply within 24 hours, depending on the severity of the problem.

**Website**

The Topcon Positioning Systems website provides current information about Topcon’s line of products. The support area of the website provides access to frequently asked questions, configuration procedures, manuals, e-mail support, etc.

To access the TPS website, use: www.topconpositioning.com
Specifications

This TPS product is a 50-channel GPS receiver integrated with an internal computer and Windows CE operating system with touch screen, a digital camera, a Bluetooth® wireless technology module, an electronic compass, and an SD card slot. The portable design and product integration allows this device to be a fully-functional, productive tool at any job.

| NOTICE | Performance specifications assume a minimum of 6 GPS satellites above 15 degrees in elevation and adherence to the procedures recommended in this manual. |
| NOTICE | In areas of high multipath, during periods of large PDOP, and during periods of increased ionospheric activity, performance may degrade. |
| NOTICE | Use robust checking procedures in areas of extreme multipath or under dense foliage. |
Specifications

### GMS-2 Specifications

The following sections provide specifications for the GMS-2 and its internal components.

#### General Details

Table A-1 table lists the receiver’s general specifications.

<table>
<thead>
<tr>
<th>Physical</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>Enclosure</td>
<td>ABS</td>
</tr>
<tr>
<td>Color</td>
<td>Topcon Yellow and Topcon Grey</td>
</tr>
<tr>
<td>Dimensions</td>
<td>W:90 x H:197 x D:46 mm</td>
</tr>
<tr>
<td>Weight</td>
<td>0.7 kg</td>
</tr>
<tr>
<td>Antenna</td>
<td>Internal</td>
</tr>
<tr>
<td>Battery</td>
<td>Internal, rechargeable/replaceable Backup, replaceable</td>
</tr>
<tr>
<td>Controller</td>
<td>Integrated; uses Windows CE operating system</td>
</tr>
</tbody>
</table>
| Keys (buttons)            | Three keys:  
|                           | Power – On/Off  
|                           | ENT – applies settings, numerical values, and records points; shows Windows Start menu  
|                           | ESC – exits from the current screen or function |
| LEDs                      | Two LEDs:  
|                           | Bluetooth – indicates Bluetooth wireless technology connection status  
|                           | Power – indicates charge level |

#### Environment

<table>
<thead>
<tr>
<th>Operating temperature</th>
<th>-20 C° to +50 C° with batteries</th>
</tr>
</thead>
<tbody>
<tr>
<td>Storage temperature</td>
<td>-30 C° to +60 C° with batteries</td>
</tr>
<tr>
<td>Waterproof</td>
<td>IP66</td>
</tr>
</tbody>
</table>
Power

<table>
<thead>
<tr>
<th>Description</th>
<th>Details</th>
</tr>
</thead>
<tbody>
<tr>
<td>Internal battery</td>
<td>2200 mAh (BT-62Q) / 2400 mAh (BT-66Q)</td>
</tr>
<tr>
<td>Operating time</td>
<td>No less than 7 hours</td>
</tr>
<tr>
<td>External power</td>
<td>1 port</td>
</tr>
<tr>
<td>Input voltage</td>
<td>8 to 15 V DC (for work) / 10 to 15 V DC (for charge battery)</td>
</tr>
<tr>
<td>Consumption</td>
<td>2.1 W (with WinCE and GPS receiver turned on)</td>
</tr>
<tr>
<td>Battery charger</td>
<td>Connect the AC adaptor to charge the power port. Available run charge when connected to a portable external power source.</td>
</tr>
<tr>
<td>Charging time</td>
<td>~6 hours for full charge</td>
</tr>
<tr>
<td>On-board</td>
<td>Backup battery for timekeeping; replaceable button-type battery; 8–10 years normal operation</td>
</tr>
</tbody>
</table>

Connectors and Slot

<table>
<thead>
<tr>
<th>Description</th>
<th>Details</th>
</tr>
</thead>
<tbody>
<tr>
<td>Serial port</td>
<td>1 port for communication with the GMS+ board (port A); small connector</td>
</tr>
<tr>
<td>USB port</td>
<td>1 port for Windows CE; type B mini ver 1.1; connect to PC using ActiveSync</td>
</tr>
<tr>
<td>External power port</td>
<td>1 port; DC Jack type A; for connecting the AC adaptor or external battery</td>
</tr>
<tr>
<td>External antenna connector</td>
<td>Lemo connector (EPS.01.250.DLN); 5 VDC output to external antenna</td>
</tr>
<tr>
<td>SD card slot</td>
<td>1 slot for memory storage and I/O</td>
</tr>
</tbody>
</table>

Communication

<table>
<thead>
<tr>
<th>Description</th>
<th>Details</th>
</tr>
</thead>
<tbody>
<tr>
<td>Serial port</td>
<td>Port A of GPS+ board</td>
</tr>
<tr>
<td></td>
<td>Baud rate = 460800, 230400, 115200, 2400, 1200, 600, 300</td>
</tr>
<tr>
<td></td>
<td>Flow control = RTC/CTS</td>
</tr>
<tr>
<td></td>
<td>Length= 7, 8 (default)</td>
</tr>
<tr>
<td></td>
<td>Stop bit= 1 (default, 2)</td>
</tr>
<tr>
<td></td>
<td>Parity= None (default), Odd, Even</td>
</tr>
</tbody>
</table>
## Specifications

Table A-1. GMS-2 General Specifications (Continued)

<table>
<thead>
<tr>
<th>Bluetooth</th>
<th>Version: Bluetooth standard 1.2; Class 2; Profile: SPP, DUP</th>
</tr>
</thead>
<tbody>
<tr>
<td>USB</td>
<td>Version 1.1</td>
</tr>
<tr>
<td><strong>Windows CE</strong></td>
<td></td>
</tr>
<tr>
<td>Processor</td>
<td>Intel PXA270</td>
</tr>
<tr>
<td>Processor speed</td>
<td>520MHz</td>
</tr>
<tr>
<td>Operating System</td>
<td>Microsoft Windows CE 5.0</td>
</tr>
<tr>
<td><strong>Digital Camera</strong></td>
<td></td>
</tr>
<tr>
<td>Pixel</td>
<td>1.3M (SXGA...1280x960)</td>
</tr>
<tr>
<td>Sensor element</td>
<td>1/4 inches color C-MOS sensor</td>
</tr>
<tr>
<td><strong>Compass</strong></td>
<td></td>
</tr>
<tr>
<td>Type</td>
<td>Magnet resistive sensor</td>
</tr>
<tr>
<td>Accuracy</td>
<td>16 divisions</td>
</tr>
<tr>
<td><strong>LCD Display</strong></td>
<td></td>
</tr>
<tr>
<td>Size</td>
<td>240x320 QVGA (portrait) 3.5 inch color TFT transmissive type</td>
</tr>
<tr>
<td>Backlight</td>
<td>LED</td>
</tr>
<tr>
<td>Touch screen</td>
<td>Resistive touch screen; passive</td>
</tr>
<tr>
<td><strong>Audio</strong></td>
<td></td>
</tr>
<tr>
<td>Speaker</td>
<td>Mono</td>
</tr>
<tr>
<td>Microphone</td>
<td>Mono</td>
</tr>
<tr>
<td><strong>Memory</strong></td>
<td></td>
</tr>
<tr>
<td>Internal memory</td>
<td>SDRAM 128MB</td>
</tr>
<tr>
<td>External memory</td>
<td>Via SD card slot</td>
</tr>
</tbody>
</table>
GPS Details

Table A-2 lists the GPS board’s general specifications.

<table>
<thead>
<tr>
<th>Table A-2. GPS Board Specifications</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Tracking Specifications</strong></td>
</tr>
<tr>
<td>Tracked Signals:</td>
</tr>
<tr>
<td>GPS/GLONASS, L1 C/A Code &amp; Carrier</td>
</tr>
<tr>
<td>WAAS/EGNOS/MSAS</td>
</tr>
<tr>
<td>Receiver Type:</td>
</tr>
<tr>
<td>G – GPS L1</td>
</tr>
<tr>
<td>GG – GPS/GLONASS L1</td>
</tr>
<tr>
<td>Standard Channels:</td>
</tr>
<tr>
<td>50</td>
</tr>
<tr>
<td>Cold Start:</td>
</tr>
<tr>
<td>&lt; 60 sec</td>
</tr>
<tr>
<td>Warm Start:</td>
</tr>
<tr>
<td>&lt; 10 sec</td>
</tr>
<tr>
<td>Reacquisition:</td>
</tr>
<tr>
<td>&lt; 1 sec</td>
</tr>
<tr>
<td><strong>Survey Accuracy</strong></td>
</tr>
<tr>
<td>Static:</td>
</tr>
<tr>
<td>For L1 – H: 3mm + 0.8ppm (x baseline length);</td>
</tr>
<tr>
<td>V: 4mm + 1.0ppm (x baseline length)</td>
</tr>
<tr>
<td>PP Kinematic:</td>
</tr>
<tr>
<td>For L1 – H: 10mm + 1.0ppm (x baseline length);</td>
</tr>
<tr>
<td>V: 15mm + 1.0ppm (x baseline length)</td>
</tr>
<tr>
<td>DGPS:</td>
</tr>
<tr>
<td>Post processing: typically 0.3m</td>
</tr>
<tr>
<td>DGPS/RTCM based: typically less than 0.5m</td>
</tr>
<tr>
<td><strong>Other (GPS)</strong></td>
</tr>
<tr>
<td>Real time data format:</td>
</tr>
<tr>
<td>RTCM 2.3, 3.0; CMR, CMR+; TPS</td>
</tr>
<tr>
<td>NMEA:</td>
</tr>
<tr>
<td>NMEA 2.2, 2.3, 3.0</td>
</tr>
<tr>
<td>Output rate:</td>
</tr>
<tr>
<td>Up to 1Hz</td>
</tr>
</tbody>
</table>
Specifications

**Connector Specifications**

The GMS-2 has one antenna connector for radio transmission/reception and three port connectors for power and data upload/download.

**Serial Connector**

The serial connector (Figure A-1) is a sealed receptacle, 5 pin, port. This connector is configured as port A of the internal GPS receiver.

![Figure A-1. Serial RS232 Connector](image)

Table A-3 gives the serial port’s pin specifications.

<table>
<thead>
<tr>
<th>Number</th>
<th>Signal Name</th>
<th>Dir</th>
<th>Details</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>TXD</td>
<td>O</td>
<td>Clear to send</td>
</tr>
<tr>
<td>2</td>
<td>RXD</td>
<td>I</td>
<td>Request to send</td>
</tr>
<tr>
<td>3</td>
<td>GND</td>
<td>-</td>
<td>Signal ground</td>
</tr>
<tr>
<td>4</td>
<td>GND</td>
<td>-</td>
<td>Signal ground</td>
</tr>
<tr>
<td>5</td>
<td>-</td>
<td>-</td>
<td>Not used</td>
</tr>
</tbody>
</table>
USB Connector

Rimmed in yellow, the USB connector is a sealed receptacle, 4 pin TPS cable connector (Figure A-2).

![USB Connector Diagram]

Figure A-2. USB Connector for GGD Options

Table A-4 gives the USB connector specifications.

Table A-4. USB Specifications

<table>
<thead>
<tr>
<th>Number</th>
<th>Signal Name</th>
<th>Dir</th>
<th>Details</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>VDD</td>
<td>P</td>
<td>Bus power input</td>
</tr>
<tr>
<td>2</td>
<td>V-</td>
<td>I/O</td>
<td>Data minus</td>
</tr>
<tr>
<td>3</td>
<td>V+</td>
<td>I/O</td>
<td>Data plus</td>
</tr>
<tr>
<td>4</td>
<td>-</td>
<td>-</td>
<td>Not used</td>
</tr>
<tr>
<td>5</td>
<td>GND</td>
<td>-</td>
<td>Ground</td>
</tr>
</tbody>
</table>
Appendix B

Safety Warnings

General Warnings

TPS receivers are designed for survey and survey related uses (that is, surveying coordinates, distances, angles and depths, and recording such measurements). This product should never be used:

- Without the user thoroughly understanding this manual.
- After disabling safety systems or altering the product.
- With unauthorized accessories.
- Without proper safeguards at the survey site.
- Contrary to applicable laws, rules, and regulations.

TPS receivers should never be used in dangerous environments. Use in rain or snow for a limited period is permitted.
Battery Pack Warnings

Never attempt to open the casing of the removable battery! Lithium-Ion batteries can be dangerous if mishandled!

Do not incinerate or the heat battery above 212° fahrenheit (100° celsius). Excessive heat can cause serious damage and possible explosion.

Tampering with the batteries by end users or non-factory authorized technicians will void the battery’s warranty.

- Do not attempt to open the battery pack or replace it.
- Do not disassemble the battery pack.
- Do not charge in conditions different than specified.
- Do not use other than the specified battery charger.
- Do not short circuit.
- Do not crush or modify.
Usage Warnings

CAUTION
If this product has been dropped, altered, transported or shipped without proper packaging, or otherwise treated without care, erroneous measurements may occur.
The owner should periodically test this product to ensure it provides accurate measurements.
Inform TPS immediately if this product does not function properly.

Only allow authorized TPS warranty service centers to service or repair this product.

WARNING
Handling the cord on this product, or cords associated with accessories sold with this product, will expose you to lead, a chemical known to the State of California to cause birth defects or other reproductive harm. Wash hands after handling.
Safety Warnings

Notes:

________________________________________________________________________

________________________________________________________________________

________________________________________________________________________

________________________________________________________________________

________________________________________________________________________

________________________________________________________________________

________________________________________________________________________

________________________________________________________________________

________________________________________________________________________

________________________________________________________________________
Appendix C

Regulatory Information

The following sections provide information on this product’s compliance with government regulations for use.

FCC Compliance

This device complies with Part 15 of the FCC rules. Operation is subject to the following two conditions:

1. This device may not cause harmful interference, and
2. This device must accept any interference received, including interference that may cause undesired operation.

This equipment has been tested and found to comply with the limits for a digital device, pursuant to Part 15 of the FCC rules. These limits are designed to provide reasonable protection against harmful interference in residential installations. This equipment generates, uses, and can radiate radio frequency energy, and if not installed and used in accordance with the instructions, may cause harmful interference to radio communications. However, there is no guarantee that interference will not occur in a particular installation.

If this equipment does cause interference to radio or television equipment reception, which can be determined by turning the equipment off and on, the user is encouraged to try to correct the interference by one or more of the following measures:

- Reorient or relocate the receiving antenna.
- Move the equipment away from the receiver.
- Plug the equipment into an outlet on a circuit different from that to which the receiver is powered.
- Consult the dealer or an experienced radio/television technician for additional suggestions.
Canadian Emission Labeling Requirements

1. Operation is subject to the following two conditions: (1) this device may not cause interference, and (2) this device must accept any interference, including interference that may cause undesired operation of the device.

2. To reduce potential radio interference to other users, the antenna type and its gain should be so chosen that the equivalent isotropically radiated power (e.i.r.p.) is not more than that permitted for successful communication.

3. This Class B digital apparatus meets all requirements of the Canadian Interference-Causing Equipment Regulations.

Cet appareil numérique de la classe B respecte conform à la norme NMB-003 du Canada.

Community of Europe Compliance

The product described in this manual is in compliance with the R&TTE and EMC directives from the European Community.
WEEE Directive

Following information is for EU-member states only:
The use of the symbol indicates that this product may not be treated as household waste. By ensuring this product is disposed of correctly, you will help prevent potential negative consequences for the environment and human health, which could otherwise be caused by inappropriate waste handling of this product. For more detailed information about the take-back and recycling of this product, please contact your supplier where you purchased the product or consult.

Perchlorate Material – Special Handling May Apply
For more information, see www.dtsc.ca.gov/hazardouswaste/perchlorate
This applies to California, USA only.
Appendix D

Warranty Terms

TPS laser and electronic positioning equipment are guaranteed against defective material and workmanship under normal use and application consistent with this Manual. The equipment is guaranteed for the period indicated, on the warranty card accompanying the product, starting from the date that the product is sold to the original purchaser by TPS' Authorized Dealers.¹

During the warranty period, TPS will, at its option, repair or replace this product at no additional charge. Repair parts and replacement products will be furnished on an exchange basis and will be either reconditioned or new. This limited warranty does not include service to repair damage to the product resulting from an accident, disaster, misuses, abuse or modification of the product.

Warranty service may be obtained from an authorized TPS warranty service dealer. If this product is delivered by mail, purchaser agrees to insure the product or assume the risk of loss or damage in transit, to prepay shipping charges to the warranty service location and to use the original shipping container or equivalent. A letter should accompany the package furnishing a description of the problem and/or defect.

The purchaser’s sole remedy shall be replacement as provided above. In no event shall TPS be liable for any damages or other claim including any claim for lost profits, lost savings or other incidental or consequential damages arising out of the use of, or inability to use, the product.

¹. The warranty against defects in a Topcon battery, charger, or cable is 90 days.
Warranty Terms
Index

A
AC/DC converter 1-12, 2-2
ActiveSync 2-8
  connecting using 3-2
  install 2-8
  no partnership 3-2
Antenna, external 1-12
  See also External antenna

B
Backup battery 1-8, 2-5
  replace 2-5
Backup data 3-9
Battery 1-8, 2-2
  charge LED 1-9
  charge time 2-2
  charging 1-8
  charging LED 2-2
  delete data 3-9, 6-1
  discharge 2-4
  hardware reset 6-4
  install 2-4
  optional charger 2-3
Battery cover 1-10
Battery performance 2-4
Beacon receiver, surveying with 3-7
Beacon, DGPS overview 1-4
Bluetooth
  blink pattern 1-9
  connecting devices 3-3
  indicator 6-6
  LED 1-9
  restore defaults 6-3
  troubleshooting 6-6
Bluetooth Manager 1-13
  about screens 5-2
  deleting devices 5-11
  discovering devices 5-6
  List of Favorite Devices 5-8
  pairing 5-13
  preferences 5-11
  properties 5-10
  serial port 6-6
  starting 5-1
  using 5-5
BT-62Q battery 2-2
  See also Battery

C
Cables 1-12
Calibrate
  compass 4-6
  touch screen 2-7
Camera 1-1, 1-7, 1-11, 4-3
  capture picture 4-4
  settings 4-3
Capture picture 4-4
Charger, battery 2-2
Charger, optional 2-3
Charging LED, blink pattern 1-9, 2-2
Charging time 2-2
Clear SDRAM 6-1
Coin battery, replace 2-5
Compass 1-1, 4-5
  calibrate 4-6
Controller 1-1
Converter, power 2-2

D
Data backup 3-9
DGPS 1-4
Differential corrections 1-4
Index

overview 1-4
Display 1-8

E
Enter button 1-9
Escape button 1-9
External antenna 1-12
    connector 1-12, A-3
    GMS Tools setting 3-6, 4-7
    surveying with 3-6

G
GALILEO 1-2
GLONASS 1-2
GMS Tools 1-13, 4-1–4-7
    capture picture 4-4
    external antenna setting 3-6
GMS-2 1-9
    cables 1-12
    software 1-13
    standard package 1-7
    system connections diagram 3-1
GMS-2, overview 1-6–1-7
GNSS, definition 1-2
GNSS, overview 1-2–1-5
GPS 1-2
GPS antenna 1-6, 1-8
GPS position 4-7

H
Hand strap 1-10
    accessing battery 2-1
    attach 2-1
    Hardware reset 6-4, 6-6

L
LED
    Bluetooth 1-9
    charging 1-9, 2-2
    Log data 4-7

N
NVRAM
    clearing 4-2, 4-9

O
OAF 1-16
OmniSTAR, DGPS overview 1-4
Operating times 1-8
Option authorization file
    See OAF

P
Port A 1-10, A-6
Ports, GMS-2 1-10
Power 1-8, 2-2
    battery depletion 1-8
    operating times 1-8
    Power port 1-10

R
RAM 2-5, 3-9
Receiver 1-1, 1-6
    connect using Bluetooth 3-8
    external 3-8
    restore defaults 6-3
RTK 1-4

S
SD card 1-11, 2-9
    accessing 1-11
    install 2-9
SDRAM A-4
    backup 2-5, 3-9
    Serial number 1-8, 2-5
    Serial port 1-10, A-3
    communication A-3
    port A 1-10, A-6
Software 1-13, 2-8
Software reset 1-11, 6-3
Stylus 1-10
Surveying 3-5–3-8
Index

standard **3-5**
with Beacon receiver **3-7**
with external antenna **3-6**
with external receiver **3-8**

**T**
Test **B-2**
Touch screen **1-8**
  calibrate **2-7**

**U**
USB port **1-10, A-3**
  connecting with computer **3-2**

**W**
Warnings **B-1**
  battery pack **B-1**
  general **B-1**
  usage **B-2**
Windows CE RAM **2-5, 3-9**